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ABSTRACT

Distillation is a continuous process in the petroleum and the chemical industries. A high amount
of energy used in the chemical and petrochemical industries is consumed in the distillation
process, since large amount of heat transfer takes place between the trays of distillation column.
Thus, there is a need of energy efficient process to be designed and controlled, in order to make
the final and the intermediate products of the distillation process of desired quality and the whole

process being more economic.

In the present study, graphical programming of LabVIEW software has been utilized to develop
model for distillation column and also to control the product stream composition. Use of virtual
instrumentation for the modeling of systems and controlling the process variables improves the
performance and reliability of the whole plant. Virtual instrumentation saves the extra cost, time
and energy that are incurred while setting up traditional instrumentation systems. It is a latest
form of modern measurement/monitoring technology where all types of measurements are done
on front panels created on PC screen. This work explores the very capability of Virtual
instrumentation to monitor and control the process variables, which is composition of the product

stream of the distillation process, and the use of LabVIEW in the field of Process control.
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CHAPTER 1

INTRODUCTION

1.1 INTRODUCTION: Distillation is a continuous process in the petroleum and the chemical

industries. Nearly, 60% of the energy used in the chemical and petrochemical industries is
consumed in the distillation process, since large amount of heat transfer takes place between the
trays of distillation column. Thus, there is a need of energy efficient process to be designed and
controlled, in order to make the final and the intermediate products of the distillation process of

desired quality and the whole process being more economic.

A Distillation column contains non - linearities, and composition interactions between
the stages due to the counter flow of vapour and liquid [1]. Various control strategies have been
designed and are being used for controlling the distillation process to maintain the composition
of top and the intermediate products. In this thesis, modeling of distillation column has
developed and, a PID control scheme has been adapted to get the end products of required

quality.

1.2 PARAMETERS AND VARIABLES OF DISTILLATION COLUMN: Distillation is the

process used for separating the different components from a liquid feed stream and purifies them.
The apparatus used for this purpose is called “Distillation Column”[14]. The distillation column
consists of many trays, condenser, reboiler, and a vertical column for the separation purpose. To
achieve the purest form of a component i.e. to achieve the desired composition of a product, one
has to control various variables of the distillation column such as temperature of trays , reflux
flow rate, distillate flow rate, vapour boilup rate and sometimes the pressure in the column also.
These variables can be altered by building a control law based on the model of the distillation

column.

This model of distillation column can be build using the differentials equations which
describes the relationship between the various variables of the column. Some of these variables

act as disturbances, some as manipulated variables, some as controlled variables and some as
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uncontrolled variables. Modeling of a distillation column contains all of these variables related
with each other in a special manner which obeys the laws of basic thermodynamics and mass —

energy balance equations.[9]

Various variables related to the distillation column can be categorized in different

categories defined above, as, [9]

1. Disturbance: This type of variables produce change in the output of a model and some
kind of control strategies are employed to nullify the effect of the disturbances. In a
distillation column disturbances are,

a. Feed Flow Rate

b. Feed Composition.

2. Manipulated Variables: These variables act as input to the plant which are varied in
such a manner, i.e. according to the control law, to maintain the output of the model at
setpoint. In a distillation column manipulated variables can be,

a. Reflux Flow Rate
b. Reboiler Heat
Distillate Flow Rate

e

&

Bottom Flow Rate

e. Cooling Flow Rate

3. Controlled Variables: Controlled variables are the output of the model or plant which
has to be maintained at the set point by varying the manipulated variables irrespective of
the effect of the disturbances. In a distillation process controlled variables are,

a. Distillate Composition
b. Bottom Composition

Level of the Reflux Drum

& o

Level of the Column Base

e. Pressure of the Column
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4. Uncontrolled Variables: Uncontrolled variables are those variables which are just used
in the modeling equations and can’t be controlled by any means used in the modeling. In
the model used in this dissertation, temperatures of various trays act as uncontrolled

variables.

Feed Flow Rate F Distillate Compaosition
Ll Ll —\-\.\
Load Disturbances _ o
Feed Composition Bottom Composition
Level Reflux Drum cantralled
" >- Variables
Level Base
Reflux Elow Rat E Pressure in Column _J
eflux Flow Rate 5 .
» o
[
c
o
Reboiler Heat b=
z
Manipulated Distillate Flow Rate
Variables < » Tray 15 Temperature
Bottom Flow Rate Tray 5 Temperature

L4
"

Uncontrolled
Variables

Cooling Water Flow Rate

.
L

L

Fig. 1.1 Different Variable in Distillation Column

Thus a model is developed based on the relations between the various variables which obey the

laws of Thermodynamics, Mass - Energy Transfer etc.

1.3 METHODOLOGY:

In the present study, LabVIEW software, a virtual instrumentation facility has been explored to
develop a model of Distillation Column and also to control the various variables such as

composition of the different products (like composition of Methanol and Water in a distillation
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process to separate methanol and water). Use of virtual instrumentation for the measurement and
monitoring the composition of products of the distillation process improves the performance and
reliability of the system. The controller for controlling the final composition of the process is

also designed using LabVIEW.

1.3.1 Why LabVIEW: Conventional methods of controlling uses hardwared controllers for the

controlling purposes of signal such as op-amp, resistors etc. to make controllers which makes the
work of the control engineer cumbersome as the system engineer has to develop and then to
design the same through different components either electrical or pneumatic. This has limited
reliability. LabVIEW provides an alternative solution to enhance the reliability and flexibility. It
uses a graphical programming language, in which the system engineer exploits the available
icons in LabVIEW Library to develop the new techniques and the strategies of controlling. Thus,
it saves extra cost, time and energy that are incurred while setting up traditional instrumentation
system. It is an innovative form of measurement/monitoring technology where all types of
measurements are done on front panels created on PC screen. Moreover, the end user i.e. the
plant operator has various options and he can monitor the physical variables remotely on the

computer screen 1.e. on the front panel of the LabVIEW.

In real situations data can be collected with the help of data acquisition technique and given to
PC through specific interfacing device. Then this raw data can be processed or analyzed by using
VI software, LabVIEW. The VI software is powerful, and can acquire, analyze and present any
signal efficiently and hence this can be very helpful for devising methods to avoid their harmful

effects.

1.4 OBJECTIVE OF THIS DISSERTATION: The objectives of this dissertation are,

1. First objective of this dissertation is to develop a model for the Binary Distillation Column
relating different variables such as composition of the Bottom Products and Distillate product.
This model contains Feed Composition (Z¢) and the feed flow (Fy) as the input Disturbances and
Distillate Flow rate and Bottom flow rate as the manipulated variables i.e. output of the

controller.
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2. Second objective of the dissertation is to develop a control strategy to maintain the product of
the distillation at the fixed composition level i.e. at set point. This dissertation also explores the
effect of the various controller parameter values on the response of the distillation column

model.

1.5 DISSECTION OF THE DISSERTATION:

The material of this dissertation has been organized in seven chapters. The contents of the

chapters are briefly outlined as indicated below.

Chapter-1 discusses on the need of controlling the distillation column and a brief outline about
the process and the involved parameters in the distillation process and gives a brief objective of
this thesis.

Chapter-2 discusses on Literature Review.

Chapter-3 discusses about the virtual instrumentation and presents features and effectiveness of
LabVIEW.

Chapter-4 gives a detailed explanation about the distillation process and its different types and
aspects.

Chapter-5 discusses about the mathematical modeling and the control strategy employed in the
thesis.

Chapter-6 discusses the integration of the distillation column model with LabVIEW.

Chapter-7 presents the results and the scope for further study.

1.6 CONCLUSION:

This chapter gives brief introduction about distillation column modeling and control, brief idea

about disturbances and other variables included in the distillation column control and discusses
about the application of Virtual instrumentation for distillation column. Also objective of this

thesis and brief outline of the project design is presented.
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CHAPTER II

LITERATURE REVIEW

2.1 DEVELOPMENTAL HISTORY OF LabVIEW: In recent years, the rapid development of

micro-electronics technology, computer technology, network communication technology and
software technology promote the rapid development of virtual machines technology. In labVIEW
environment, real time power quality monitoring can be developed using Virtual Instrumentation
concept. This is done with data acquisition system, which can transmit the measured signal any

far-away place via guided or unguided media without distorting the original signals.

Virtual Instrumentation is an interdisciplinary field that merges sensing, hardware, and software
technologies in order to create flexible and sophisticated instruments for control and monitoring
applications. The concept of virtual instrumentation was born in late 1970s, when
microprocessor technology enabled a machine’s function to be more easily changed by changing
its software. The flexibility is possible as the capabilities of a virtual instrument depend very
little on dedicated hardware. A history of virtual instrumentation is characterized by continuous
increase of flexibility and scalability of measurement equipment. Nearly all of the instrument
control programs were written in BASIC, because it had been the dominant language used with
dedicated instrument controllers. It required engineers and other users to become programmers
before becoming instrument users, so it was hard for them to exploit potential that computerized
instrumentation could bring. Therefore, an important milestone in the history of virtual
instrumentation happened in 1986, when National Instruments introduced LabVIEW 1.0 on a PC
platform. LabVIEW introduced graphical user interfaces and visual programming into
computerized instrumentation, joining simplicity of a user interface operation with increased
capabilities of computers. Today, the PC is the platform on which most measurements are made,
and the graphical user interface has made measurements user-friendlier. As a result, virtual
instrumentation made possible decrease in price of an instrument. As the virtual instrument
depends very little on dedicated hardware, a customer could now use his own computer, while an

instrument manufacturer could supply only what the user could not get in the general market.
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Virtual instrumentation combines mainstream commercial technologies, such as the PC, with
flexible software and wide variety of measurement and control hardware, so engineers and
scientists can create user defined system that meet their exact application needs. With Virtual
instrumentation, engineers and scientist reduce development time, design higher quality

products, and lower their design costs.

Virtual Instruments is basically used for displaying test or measurement data collected by the
external device on instruments like panels on a computer screen. Thus Virtual Instrumentation

uses a general purpose computer to mimic real instruments with their controls and displays.

The virtual instrument technology platform for the development of power quality monitoring
system is flexible, easy to upgrade, able to overcome the traditional test and measurement system
shortcomings, such as a single function and the complexity of the upgrade. Their functions are
chosen by users and can be extended or modified according to users’ requirements in contrast
with traditional instrumentation (multimeters, oscilloscopes etc.) where the functions are vendor

defined by hardware.

2.2 LITERATURE SURVEY ON DISTILLATION COLUMN CONTROL.:

Jiann-Shiou Yang [1] developed the PI/PID control of a binary distillation column via a genetic
searching algorithm (GSA). The time-domain design criterion, expressed as an integral of the
squared error, is reformulated in the frequency-domain using the Parseval's relation and Padé
approximation. A genetic algorithm is then used to search over the stability region in the

controller parameter space for the best settings to minimize the design criterion.

Imam Makaremi [2] has presented a decentralized controller for a binary distillation column.
The interactions between subsystems are considered as uncertainty. Then appropriate local Hoo
problems are defined such that by solving them and applying the designed controller to the

system, closed-loop stability and diagonal dominance are guaranteed.
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Islam Mohamed Adel, Irraivan Elamvazuthi [3] has designed a model and simulated the
control process of a binary methanol-water pilot plant and has analyzed the PI tuning techniques

of Cohen-coon, Multi loop, Ziegler — Nichols and ITAE.

Raji P, Binu L S [4] have presented the application of sliding mode controller for a high purity
binary distillation column. The main goal of the controller is to control the top and bottom
product composition of a binary distillation column with high purity. They have used boilup rate

V and the reflux rate R as the manipulated variables.

Ronia M. Oisiovici, Sandra L. Cruz [5] In this work, a linear time-varying state-space model
for batch distillation columns was developed and tested. The model is suitable for on-line
implementation and to predict the system behavior from measurable and easily available
information. Comparing the model predictions with the rigorous simulation results, the state-
space model was able to predict the batch distillation column behavior accurately, even for the

nonideal mixture ethanol/water.

M. T. Tham [6] has presented the explanation and the various methods of distillation and
components of the distillation column. In addition to that he has presented various distillation

principles and the design of distillation column.

Vu Trieu Minh and Ahmed Majdi Abdul Rani [7] have introduced a calculation procedure for
the modeling and control simulation of a condensate distillation column based on the energy
balance (L-V) structure. In this control, the Reflux Rate L and the boilup Rate V are used as the
inputs to the control the output of the purity of the distillate overhead and the impurity of the
bottom products. The modeling simulation is important for process dynamic analysis and the
plant initial design. This work has accomplished the modeling and simulation over three phases,
nonlinear model of the plant, full order linearized model and the reduced order linear model.

MRAC scheme has then been used for the controlling purposes.

J. Fernandez de Canete, P. Del Saz Orozco and S. Gonzalez-Perez [8] In this paper a

LabVIEW environment has been employed as a graphical user interface for monitoring the
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operation of a controlled distillation column, by visualizing both the closed loop performance
and the user selected control conditions, while the column dynamics has been modeled under the
SIMULINK environment. This tool has been applied to the PID based decoupled control of a

binary distillation column.

Norrie and M. T. Tham have presented a detailed description of the distillation column

components such as reflux drum, Tray types etc.

2.3 CONCLUSION: An extensive literature review of distillation column modeling and control

using LabVIEW has been presented in this chapter.
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CHAPTER 111
Overview of labVIEW

3.1 VIRTUAL INSTRUMENTATION

Virtual instrumentation sets a new standard in measurement by replacing bench top instruments.
It uses software like NI LabVIEW and hardware like PCI modules for data acquisition,
instrument control and automation. VIs constructed with software are inexpensive, more
accurate, maintenance free, can sense different physical quantities offering any range, compared
to physical instruments. VIs works fast, handles repetitive tasks, processes data, stores results,
generates reports, increases test safety and is controllable by the user. It saves time, money and
increases productivity; customizability e.g. same code can be re-used for testing similar
instruments. For any lab instead of buying individual instruments, VI can be employed in a

computer for all measurements.

3.1.1 Virtual Instruments versus Traditional Instruments

Traditional instruments: Vendor defined, Function-specific; stand-alone with limited
connectivity. Hardware is the key, Expensive, Closed, fixed functionality, slow turn on
technology (5-10 year life Minimal economics of scale).

Virtual Instruments: User-defined, Application-oriented system with connectivity to networks,
peripherals, and applications. Software is the key, low cost, reusable, Open, flexible functionality
leveraging off familiar computer technology (Maximum economics of scale). Software

minimizes development and maintenance costs.[11,15]

3.1.2 PROGRAMMING TECHNIQUES

LabVIEW programs are called virtual instruments or VIs, because their appearance and

operation imitate physical instruments, such as oscilloscopes and millimeters. LabVIEW VIs
contain three components: the front panel window, the block diagram, and the icon/connector

pane.[11,15]
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Front panel Window

The Front panel window is the user interface for the VI. Fig.3.2 shows example of a front panel

window. We create the front panel window with controls and indicators, which are the

interactive input and output terminals of the VI, respectively.
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Fig.3.1 VI Front Panel
Block Diagram Window

After creating the Front Panel Window, we add code using graphical representation of functions

to control the Front panel objects. Fig.3.3 shows an example of a block diagram window contains

this graphical source code. Front panel objects appear as terminals on the block diagram.

B! Using Temperature.vi Diagram =

Fil= Edit Operate Toolz Browsse “Window Help 11::51:
| o I{E}I @l [ ]| I | ) I ||-H:||'E'||:|ﬂ | 13pt Application Font |- Il :,;,v"‘._u"_‘-vllfg'h
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Fig. 3.2 VI Block Diagram
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Icon and Connector Pane

A VI can be used as a subVI. A subVI is a VI that is used in another VI, similar to a function in
a text based programming language. To use VI as a subVI, it must have an icon and connector

Pane.

Fig. 3.3 Icon for SubVI
Every VI displays an icon, shown above, in the upper right corner of the front panel and block
diagram windows. An icon is a graphical representation of a VI. It can contain text, images, or a
combination of both. If we use a VI as a subVI, the icon identifies the subVI on the block
diagram of the VI. The default icon contains a number that indicates how many new VIs we have
opened since launching LabVIEW. Create custom icons to replace the default icon by right-
clicking the icon in the upper right corner of the front panel or block diagram and selecting Edit
Icon from the shortcut menu or by double-clicking the icon in the upper right corner of the front
panel. We also can edit icons by selecting File»VI Properties, selecting General from the
Category pull-down menu, and clicking the Edit Icon button. Use the tools on the left side of the
Icon Editor Dialog box to create the icon design in the editing area. The normal size image of the
icon appears in the appropriate box to the right of the editing area, as shown in the following

dialog box in Fig.3.4.

{B lcon Editor
Fle Edt Help

B & Copy from:

(DD Black &\while
(3 16 Colors

() 25 Calors

™ Show Teminals

ak
Cancel

Fig. 3.4 Icon Editor
Use the options on the right side of the editing area to perform the following tasks:
* Show Terminals—Displays the terminal pattern of the connector pane.
* OK—Saves the drawing as the icon and returns to the front panel.

* Cancel—Returns to the front panel without saving any changes.

Delhi Collage of Engineering Page 21



Modeling and Control of Binary Distillation Column usin LabVIEW

The menu bar in the Icon Editor dialog box contains more editing options such as Undo, Redo,

Cut, Copy, Paste, and Clear.

To use a VI as a subVI, we need to build a connector pane, shown at left. The connector

pane is a set of terminals that corresponds to the controls and indicators of that VI, similar to the
parameter list of a function call in text-based programming languages. The connector pane
defines the inputs and outputs we can wire to the VI so we can use it as a subVI. Define
connections by assigning a front panel control or indicator to each of the connector pane
terminals. To define a connector pane, right-click the icon in the upper right corner of the front
panel window and select Show Connector from the shortcut menu. The connector pane replaces
the icon. Each rectangle on the connector pane represents a terminal. Use the rectangles to assign
inputs and outputs. The number of terminals LabVIEW displays on the connector pane depends
on the number of controls and indicators on the front panel. The following front panel has four
controls and one indicator, so LabVIEW displays four input terminals and one output terminal on

the connector pane. We cannot access the connector pane from the icon in the block diagram

window.
Boowsi _____________________ EEE|
Fil= Edit Opcrate Tool: Browse Window Hep
= I@ @E [ ~3p: Application Fort [« :Dv"ﬁ:v”m E]
=
31 Rl
i e
Slape Im]
0.00
¥z Y2
£ [T B [ |
Kl | Ll_ﬁl
Fig. 3.5 icon/connector pane on top right side (orange colour box)
Palettes

LabVIEW has graphical, floating palettes to help you create and run VIs. The three palettes
include the Tools, Controls, and Functions palettes. We can place these palettes anywhere on
the screen.

Tools Palette

We can create, modify, and debug VIs using the tools located on the floating Tools palette. The
Tools palette is available on the front panel and the block diagram. A tool is a special operating

mode of the mouse cursor. When we select a tool, the cursor icon by itself changes to the tool
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icon. Use the tools to operate and modify front panel and block diagram objects. Next select
Window»Show Tools Palette to display the Tools palette. We can place the Tools palette
anywhere on the screen. Press the <Shift> key and right-click to display a temporary version of

the Tools palette at the location of the cursor.

il Tools

5

1 il
%2

A4

0y~

Fig 3.6 Tools palette

@Use the Operating tool to change the values of a control or select the text within a control.
IEUse the Positioning tool to select, move, or resize objects

@Use the Wiring tool to wire objects together on the block diagram.

Control and Function Palettes

The Controls and Functions contain sub-palettes of objects to create a VI. When click on sub-
palette icon, the entire palette changes to the selected sub-palette. To use an object on the
palettes, click the object and place it on the front panel or block diagram.

Controls Palette

Use the Controls palette to place controls and indicators on the front panel. The Controls palette
is available only on the front panel. From there select Window»Show Controls Palette or right-
click on the front panel workspace in order to display the Controls palette. We also can display
the Controls palette by right-clicking an open area on the front panel. Tack down the Controls

palette by clicking the pushpin on the top left corner of the palette.
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Fig 3.7 Control Palette
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Functions Palette

Use the Functions palette to build the block diagram. The Functions palette is available only on
the block diagram. Select Window»Show Functions Palette or right-click the block diagram
workspace to display the Functions palette. You also can display the Functions palette by right-
clicking an open area on the block diagram. Tack down the Functions palette by clicking the

pushpin on the top left corner of the palette.

Fig 3.8 Function palette

3.1.3 Starting a VI

When we launch LabVIEW, the following dialog box appears.

Fig 3.9 Start window that appears when labVIEW is launched
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Fig 3.10 Dialog box for Getting Started of LabVIEW
The LabVIEW dialog box includes the following components:
* Click the New VI button to create a new VI.
* Click the Open VI button to open an existing VI.
* Click the DAQ Solutions button to launch the DAQ Solution Wizard, which helps we find
solutions for common DAQ applications.

* Click the Search Examples button to open a help file that lists and links to all available

LabVIEW example VIs
* Click the LabVIEW Tutorial button to open the interactive LabVIEW Tutorial. Use this

tutorial to learn basic LabVIEW concepts.

3.1.4 Troubleshooting and Debugging VIs
Use the Context Help window and the LabVIEW Help to help you build and edit Vls.
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Context Help Window

To display the Context Help window, select Help » Show Context Help or press the <Ctrl-
H>key. When we move the cursor over front panel and block diagram objects, the Context Help
window displays the icon for sub VIs, functions, constants, controls and indicators, with wires
attached to each terminal. When we move the cursor over dialog box options, the Context Help
window displays descriptions of those options. In the window, required connections are bold,
recommended connections are plain text, and optional connections are dimmed or do not appear.

The following is an example Context Help window.

refrium

new il path
file size [bytes]
Errar aut

Funcion [oper:0]
BIror in [not an error]
default name

Open/Create/Replace File.vi

Opens an existing file, creates a new file, or replaces an existing file,
proarammatically or interactively using a file dialog box

Click here for more help_ =

=[&[Z14] A |

Fig. 3.11 shows Context Help
2IClick the More Help button to display the corresponding topic in the LabVIEW Help, which

describes the object in detail.

3. 2 Advantages of VI:

Long before people used typewriters, which were then replaced by the word processors that

offered new levels of productivity and flexibility. Much as the same way, VIs will replace the

physical instruments.

Fig. 3.12 Comparison of the Virtual Instrument and Traditional Instrument
The picture on the top is that of a real instrument and the one on the bottom is that of a virtual
one. Today's computer's graphic capabilities even make VIs look like real instruments. Virtual

instruments are better connected to PC technologies widely used in industries. With VI, users can
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move applications seamlessly between several bus architectures, such as PC Card, plug-in DA
hardware, and VXI. This portability offers the flexibility to take advantage of improved bus
standards as they arise.

3.2.1 Customizability VIs are fully customizable. Range, accuracy, amount of information

provided by them can be selected by users. Data can be saved in computer and send it over the
internet. They can be made to sense any physical quantity offering any range with the use of
corresponding sensors. A VI can be made to control any other instruments including another VI.

3.2.2 Increases productivity VIs are less expensive and maintenance free. They work very fast,

handle repetitive tasks, process data, store results and also generate reports. Reuse of code is also
possible. Thus the same code can be used for testing similar instruments which saves time and
money. Doing things in less time would definitely mean being able to do more. With less time,
money and human labour for the same product, the productivity increases rapidly.

3.2.3 Lowers cost for customers Physical instruments are not suited for extreme weathers, but

VIs can work in any hazardous environments. When a new product is tested using expensive test
equipments, it naturally raises the overhead cost. Employing VI there reduces the testing cost.
They also increase the test safety. They do not get damaged and thus no need of replacements.
This lessens the price of the final product for customers.

3.2.4 User friendliness The software used for VI is user friendly. In LabVIEW, new users can

step through the dialogue boxes and quickly build a fully functioning DA application. LabVIEW
will help define signal types, connections, and transducer equations before building the system.
Thus, the learning curve is shortened significantly. More experienced developers can use the
DAQ Wizards to prototype a system.

Most VI system contains a microprocessor, a data-acquisition unit or system, an I/O port, a
display or a way of reporting the results and an analysis engine. Since most of the hardware is
the same, only the front-end of the device needs to be changed to suit the equipment's purpose.
With a personal computer, software could do the analysis after acquiring the needed data. Thus,
the software could be written as such to specifically answer what is called for by the analysis.
The hardware could be changed according to the design of the experiment, whether it will
receive data from an apparatus or control it. Instead of using separate hardware front-ends,
software could be written for measuring different quantities. Thus with sensors and appropriate

software, any physical quantity can be acquired and measured in VI.
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Some other applications of VI are data analysis, systems control, process automation, testing and
calibration of instruments, telecommunications, semiconductor manufacturing, automotive

testing, robotics, automation, embedded systems, etc.

3.3 CONCLUSION

The future of virtual instrumentation is promising. As such companies as Intel and Microsoft
continue to usher in new technologies for advanced productivity and connectivity; virtual
instrumentation’s benefits will increase. Improvements in PC technology and VI hardware and
software will make new applications possible. Companies like National Instruments are
promoting VI to make it reach everyone. Quite sooner the traditional instrumentation will be

completely moved inside the computer.
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CHAPTER 1V

INTRODUCTION TO DISTILLATION PROCESS

4.1 INTRODUCTION: Distillation is the very basic and common process in the chemical and

in petroleum industries. It is used for separating feed streams and for purification of final and

intermediate product streams. More precisely it can be defined as,

“A process in which a liquid or vapour mixture of two or more substances is separated into

its component fractions of desired purity, by the application and removal of heat.”’[1][14]

4.1.1 BASIC PRINCIPLE OF DISTILLATION PROCESS:

Distillation is based on the fact that the vapour of a boiling mixture will be richer in the

components that have lower boiling points. Therefore, when this vapour is cooled and
condensed, the condensate will contain more volatile components. At the same time, the original
mixture will contain more of the less volatile material. Distillation columns are designed and
controlled to achieve this separation efficiently. Although many people have a fair idea what
“distillation” means, the important aspects that seem to be missed from the manufacturing point
of view are that: Distillation is the most common separation technique and it consumes enormous
amounts of energy, both in terms of cooling and heating requirements. It can contribute to more
than 50% of plant operating costs. The best way to reduce operating costs of existing units, is to
improve their efficiency and operation via process optimization and control. To achieve this
improvement, a thorough understanding of distillation principles and how distillation systems are

designed is essential [14].

4.2 HISTORICAL ASPECTS OF DISTILLATION:

The first clear evidence of distillation comes from Greek alchemists working in Alexandria in the

first century AD[16]. Distilled water has been known since at least ca. 200 AD, when Alexander
of Aphrodisias described the process [17]. Clear evidence of the distillation of alcohol comes
from the School of Salerno in the 12th century [16][18].Fractional distillation was developed

by Tadeo Alderotti in the 13th century [19] . In 1500, German alchemist Hieronymus
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Braunschweig published ‘Liber de arte destillandi’ (The Book of the Art of Distillation) the first
book solely dedicated to the subject of distillation, followed in 1512 by a much expanded
version. In 1651, John French published, The Art of Distillation, the first major English
compendium of practice, though it has been claimed [20] that much of it derives from
Braunschweig's work. This includes diagrams with people in them showing the industrial rather
than bench scale of the operation. As alchemy evolved into the science of chemistry, vessels
called ‘retorts’ became used for distillations. Both alembics and retorts are forms of glassware
with long necks pointing to the side at a downward angle which acted as air-cooled condensers to
condense the distillate and let it drip downward for collection. Later, copper alembics were
invented. Riveted joints were often kept tight by using various mixtures, for instance a dough

made of rye flour.

Fig. 4.1 A Retort

These alembics often featured a cooling system around the beak, using cold water for instance,
which made the condensation of alcohol more efficient. These were called pot stills. Today, the
retorts and pot stills have been largely supplanted by more efficient distillation methods in most
industrial processes. However, the pot still is still widely used for the elaboration of some fine
alcohols such as cognac. Pot stills made of various materials (wood, clay, stainless steel) are also
used by bootleggers in various countries. Small pot stills are also sold for the domestic
production of flower water or essential oils. Early forms of distillation were batch processes
using one vaporization and one condensation. Purity was improved by further distillation of the

condensate.
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Fig. 4.2 An earlier method for Distillation
Greater volumes were processed by simply repeating the distillation. Chemists were reported to
carry out as many as 500 to 600 distillations in order to obtain a pure compound. In the early
19th century the basics of modern techniques including pre-heating and reflux were developed,
particularly by the French, and then in 1830 a British Patent was issued to Aeneas Coffey for a
whiskey distillation column, which worked continuously and may be regarded as the archetype
of modern petrochemical units. In 1877, Ernest Solvay was granted a U.S. Patent for a tray
column for ammonia distillation and the same and subsequent years saw developments of this
theme for oil and spirits. With the emergence of chemical engineering as a discipline at the end
of the 19th century, scientific rather than empirical methods could be applied. The developing
petroleum industry in the early 20th century provided the impetus for the development of
accurate design methods such as the McCabe-Thiele method and the Fenske equation. In
present era the availability of powerful computers has also allowed direct computer simulation of

distillation columns.

4.3 TYPES OF DISTTILLATION PROCESS:

There are two major types of distillation processes i.e.,

4.3.1 Batch Distillation: In batch operation, the feed to the column is introduced batch-

wise. That is, the column is charged with a 'batch' and then the distillation process is
carried out. When the desired task is achieved, a next batch of feed is introduced [2].
Heating an ideal mixture of two volatile substances A and B (with A having the
higher volatility, or lower boiling point) in a batch distillation setup (such as in an

apparatus depicted in the following figure)
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Fig. 4.3 Basic Distillation Process

until the mixture is boiling results in a vapor above the liquid which contains a mixture of A and
B. The ratio between A and B in the vapor will be different from the ratio in the liquid: the ratio
in the liquid will be determined by how the original mixture was prepared, while the ratio in the
vapor will be enriched in the more volatile compound, A (due to Raoult’s Law, see above). The
vapor goes through the condenser and is removed from the system. This in turn means that the
ratio of compounds in the remaining liquid is now different from the initial ratio (i.e. more
enriched in B than the starting liquid). The result is that the ratio in the liquid mixture is
changing, becoming richer in component B. This causes the boiling point of the mixture to rise,
which in turn results in a rise in the temperature in the vapor, which results in a changing ratio of
A : B in the gas phase (as distillation continues, there is an increasing proportion of B in the gas
phase). This results in a slowly changing ratio A : B in the distillate. If the difference in vapor
pressure between the two components A and B is large (generally expressed as the difference in
boiling points), the mixture in the beginning of the distillation is highly enriched in component
A, and when component A has distilled off, the boiling liquid is enriched in component B.

This type of distillation is generally used in Laboratory scale Distillation, since the product of the

process is in little amount. Laboratory scale distillations are of different types, such as,

(1) Simple Distillation: In simple distillation, all the hot vapors produced are
immediately channeled into a condenser that cools and condenses the vapors.

Therefore, the distillate will not be pure — its composition will be identical to the
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composition of the vapors at the given temperature and pressure, and can be
computed from Raoult’s law. As a result, simple distillation is usually used only to
separate liquids whose boiling points differ greatly (rule of thumb is 25 °C), or to
separate liquids from involatile solids or oils. For these cases, the vapor pressures of
the components are usually sufficiently different that Raoult’s law may be neglected
due to the insignificant contribution of the less volatile component. In this case, the

distillate may be sufficiently pure for its intended purpose.

(i1) Fractional distillation: For many cases, the boiling points of the components in the
mixture will be sufficiently close that Raoult’s law must be taken into consideration.
Therefore, fractional distillation must be used in order to separate the components
well by repeated vaporization-condensation cycles within a packed fractionating
column. This separation, by successive distillations, is also referred to as
rectification.[21] As the solution to be purified is heated, its vapors rise to the
fractionating column. As it rises, it cools, condensing on the condenser walls and the
surfaces of the packing material. Here, the condensate continues to be heated by the
rising hot vapors; it vaporizes once more. However, the compositions of the fresh
vapors are determined once again by Raoult’s law. Each vaporization-condensation
cycle (called a theoretical plate) will yield a purer solution of the more volatile
component. In reality, each cycle at a given temperature does not occur at exactly the
same position in the fractionating column; theoretical plate is thus a concept rather
than an accurate description. More theoretical plates lead to better separations. A
spinning band distillation system uses a spinning band of Teflon or metal to force the
rising vapors into close contact with the descending condensate, increasing the

number of theoretical plates.

(iii)  Steam distillation: Like vacuum distillation, steam distillation is a method for
distilling compounds which are heat-sensitive.[22] This process involves bubbling
steam through a heated mixture of the raw material. By Raoult’s law, some of the
target compound will vaporize (in accordance with its partial pressure). The vapor

mixture is cooled and condensed, usually yielding a layer of oil and a layer of water.
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Steam distillation of various aromatic herbs and flowers can result in two products; an
essential oil as well as a watery herbal distillate. The essential oils are often used in
perfumery and aromatherapy while the watery distillates have many applications in
aromatherapy, food processing and skin care.

(iv)  Vacuum distillation: Some compounds have very high boiling points. To boil such
compounds, it is often better to lower the pressure at which such compounds are
boiled instead of increasing the temperature. Once the pressure is lowered to the
vapor pressure of the compound (at the given temperature), boiling and the rest of the
distillation process can commence. This technique is referred to as vacuum
distillation and it is commonly found in the laboratory in the form of the rotary
evaporator. This technique is also very useful for compounds which boil beyond their
decomposition temperature at atmospheric pressure and which would therefore be

decomposed by any attempt to boil them under atmospheric pressure.

V) Molecular distillation: Molecular distillation is vacuum distillation below the
pressure of 0.01 torr. 0.01 torr is one order of magnitude above high vacuum, where
fluids are in the free molecular flow regime, i.e. the mean free path of molecules is
comparable to the size of the equipment. The gaseous phase no longer exerts
significant pressure on the substance to be evaporated, and consequently, rate of
evaporation no longer depends on pressure. That is, because the continuum
assumptions of fluid dynamics no longer apply, mass transport is governed by
molecular dynamics rather than fluid dynamics. Thus, a short path between the hot
surface and the cold surface is necessary, typically by suspending a hot plate covered
with a film of feed next to a cold plate with a line of sight in between. Molecular

distillation is used industrially for purification of oils.

4.3.2 Continuous distillation: Continuous distillation processes a continuous feed stream.

No interruptions occur unless there is a problem with the column or surrounding
process units. They are capable of handling high throughputs and are the more
common of the two types i.e. among batch and continuous distillation. Industrial
distillation comes under the category of continuous distillation. In this dissertation

only continuous distillation is modeled and controlled.
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(i) Industrial Distillation: Large scale industrial distillation applications include both
batch and continuous fractional, vacuum, azeotropic, extractive, and steam
distillation. The most widely used industrial applications of continuous, steady-state
fractional distillation are in petroleum refineries, petrochemical and chemical plants
and natural gas processing plants. Industrial distillation[21][23] is typically performed
in large, vertical cylindrical columns known as distillation towers or distillation
columns with diameters ranging from about 65 centimeters to 16 meters and heights
ranging from about 6 meters to 90 meters or more. When the process feed has a
diverse composition, as in distilling crude oil, liquid outlets at intervals up the column
allow for the withdrawal of different fractions or products having different boiling
points or boiling ranges. The “lightest” products (those with the lowest boiling point)
exit from the top of the columns and the “heaviest” products (those with the highest
boiling point) exit from the bottom of the column and are often called the bottoms.
Industrial towers use reflux to achieve a more complete separation of products.
Reflux refers to the portion of the condensed overhead liquid product from a
distillation or fractionation tower that is returned to the upper part of the tower as
shown in the schematic diagram of a typical, large-scale industrial distillation tower.
Inside the tower, the down flowing reflux liquid provides cooling and condensation of
the up flowing vapors thereby increasing the efficiency of the distillation tower. The
more reflux that is provided for a given number of theoretical plates, the better the
tower’s separation of lower boiling materials from higher boiling materials.
Alternatively, the more reflux that is provided for a given desired separation, the
fewer the number of theoretical plates required. Such industrial fractionating towers
are also used in air separation, producing liquid oxygen, liquid nitrogen, and high
purity argon. Distillation of chlorosilanes also enables the production of high purity
silicon for use as a semiconductor. Design and operation of a distillation tower
depends on the feed and desired products. Given a simple, binary component feed,
analytical methods such as the McCabe-Thiele method [21][24] or the Fenske
equation[21] can be used. For a multi component feed, simulation models are used
both for design and operation. Moreover, the efficiencies of the vapor-liquid contact

devices (referred to as “plates” or “trays”) used in distillation towers are typically
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lower than that of a theoretical 100% efficient equilibrium stage. Hence, a distillation
tower needs more trays than the number of theoretical vapor-liquid equilibrium
stages. In modern industrial uses, generally a packing material is used in the column
instead of trays, especially when low pressure drops across the column are required,
as when operating under vacuum. This packing material can either be random
dumped packing (1-3” wide) such as Raschig rings or structured sheet metal. Liquids
tend to wet the surface of the packing and the vapors pass across this wetted surface,
where mass transfer takes place. Unlike conventional tray distillation in which every
tray represents a separate point of vapor-liquid equilibrium, the vapor-liquid
equilibrium curve in a packed column is continuous. However, when modeling
packed columns, it is useful to compute a number of “theoretical stages” to denote the
separation efficiency of the packed column with respect to more traditional trays.
Differently shaped packings have different surface areas and void space between
packings. Both of these factors affect packing performance. Another factor in
addition to the packing shape and surface area that affects the performance of random
or structured packing is the liquid and vapor distribution entering the packed bed. The
number of theoretical stages required to make a given separation is calculated using a
specific vapor to liquid ratio. If the liquid and vapor are not evenly distributed across
the superficial tower area as it enters the packed bed, the liquid to vapor ratio will not
be correct in the packed bed and the required separation will not be achieved. The
packing will appear to not be working properly. The height equivalent of a theoretical
plate (HETP) will be greater than expected. The problem is not the packing itself but
the mal-distribution of the fluids entering the packed bed. Liquid mal-distribution is
more frequently the problem than vapor. The design of the liquid distributors used to
introduce the feed and reflux to a packed bed is critical to making the packing
perform to it maximum efficiency. Methods of evaluating the effectiveness of a liquid
distributor to evenly distribute the liquid entering a packed bed can be found in

references.
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Industrial distillation is typically performed in large, vertical cylindrical columns (as shown in
Figure ) known as "distillation towers" or "distillation columns" with diameters ranging from
about 65 centimeters to 6 meters and heights ranging from about 6 meters to 60 meters or more.
Industrial distillation towers are usually operated at a continuous steady state. Unless disturbed
by changes in feed, heat, ambient temperature, or condensing, the amount of feed being added
normally equals the amount of product being removed. It should also be noted that the amount of
heat entering the column from the reboiler and with the feed must equal the amount heat
removed by the overhead condenser and with the products. Figure 3 depicts an industrial
fractionating column separating a feed stream into one distillate fraction and one bottoms

fraction.
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Fig. 4.5 Schematic Diagram of Binary Distillation Column
However, many industrial fractionating columns have outlets at intervals up the column so that
multiple products having different boiling ranges may be withdrawn from a column distilling a
multi-component feed stream. The "lightest" products with the lowest boiling points exit from
the top of the columns and the "heaviest" products with the highest boiling points exit from the
bottom. Industrial fractionating columns use external reflux to achieve better separation of
products.[26][21] Reflux refers to the portion of the condensed overhead liquid product that
returns to the upper part of the fractionating column as shown in Figure 3. Inside the column, the
downflowing reflux liquid provides cooling and condensation of upflowing vapors thereby
increasing the efficacy of the distillation tower. The more reflux and/or more trays provided, the
better is the tower's separation of lower boiling materials from higher boiling materials. The
design and operation of a fractionating column depends on the composition of the feed and as
well as the composition of the desired products. Given a simple, binary component feed,
analytical methods such as the McCabe-Thiele method [21][27][28] or the Fenske equation[21]
can be used. For a multi-component feed, simulation models are used both for design, operation
and construction. Bubble-cap "trays" or "plates" are one of the types of physical devices which
are used to provide good contact between the up flowing vapor and the down flowing liquid
inside an industrial fractionating column. Such trays are shown in Figures 4 and 5. The

efficiency of a tray or plate is typically lower than that of a theoretical 100% efficient
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equilibrium stage. Hence, a fractionating column almost always needs more actual, physical

plates than the required number of theoretical vapor-liquid equilibrium stages.

4.4 DISTILLATION COLUMN/TOWER:

Distillation columns or towers are constructed to behave in the same way as a series of separate
stills as discussed earlier. Each 'still' section consists of a number of "TRAYS' or contacting
devices arranged vertically above one another in the column. These trays or contactors bring
liquid and vapour into intimate contact in order to obtain the required separation of the mixture.
The height of the tower and the number of trays or contacting devices it contains depends upon

the purity of the 'Fractions' required. Columns for the distillation process can be of the following

types:

1. The 'PACKED' Tower
2. The 'TRAY' Tower

44.1 PACKED TOWER: As its name implies, the packed tower is a vertical, steel
column which contains 'Beds' of packing material which are used to bring the rising
vapours into intimate contact with falling liquid within the tower. The heat added to
the mixture before entering the tower partially vaporises the mixture and the vapours
rise up the tower and begin to cool. The liquid falls towards the bottom of the tower.
At the tower bottom, in general, more heat is added to the liquid by a 'Reboiler' which
may be steam heated or a fuel fired furnace type. The addition of heat here causes
more vapours to rise up the column. As the two phases of the mixture - falling liquid
and rising vapour - come together, light components are stripped out of the liquid and
enter the gas phase while heavy components in the vapour are condensed into the
liquid phase. In this way, as the vapour rises and gradually cools, it becomes lighter
and, as the liquid falls, it becomes hotter and heavier. With this type of distillation
column there is generally only a top and bottom product. The quality of the products
depends upon the height of the tower, the number of contacting devices, the tower
temperature and pressure and their control, and the velocity of the rising vapours. The

type of packing materials used, also plays a part in the separation process. The
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packing can be of such types as, Ceramic Raschig Rings, Stainless Steel Pall Rings or
Ceramic Saddles.

TRAY TYPE TOWER: This is also a tall, cylindrical column. Inside, a series of
trays are placed, one above the other. The trays are used to bring the rising vapour
and falling liquid into intimate contact. Tray towers do the same job as packed towers
but they are very much more efficient in the separation process than packed towers
and, they are also more costly. There are various types of tray in use and the type
selected depends upon the degree of product purity required, the type of fluids, fluid
velocity and other process parameters of the system.

The types of tray used in distillation columns are as follows:
(a) THE SIEVE TRAY is simply a metal plate containing drilled holes through which

the rising vapour can pass into the liquid flowing across the tray.

OPERATION OF A SIEVE TRAY
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Fig. 4.6 Sieve Tray
(b) THE VALVE TRAY is similar to the sieve type but, each hole is fitted with a
flapper valve which opens as vapour passes through the hole. This type is used
where vapour velocity is not constant and the valves prevent liquid from dumping

through the holes at times of low gas velocity.
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(c) THE BUBBLE-CAP TRAY is the most efficient separation device but, is also the
most costly. It consists of a number of 'Chimneys' or 'Risers' (small, short pipes
set into the tray), through which the vapour can pass. Fitted over the riser is a
'Cap' which causes the rising vapour to turn through 180 °. This forces the gas to
'‘Bubble' through the liquid flowing across the tray. The liquid level on the tray is
maintained below the top of the riser to prevent dumping of liquid down the

tower.
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Flg 4.7 Bubble Cap Tray
Each of the above trays also has a 'WEIR' that maintains the liquid level on the tray. As the
liquid flows over the weir, it enters a DOWNCOMER' - (a short pipe), that carries the liquid
down to the tray below. The downcomer outlet is below the surface of the liquid on the tray

below, acting as a seal to prevent gas from bypassing the tray above.
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4.5 BASIC CONTINUOUS DISTILLATION PROCESS FOR PETROLEUM
INDUSTRIES: Figure 4.8 represents a basic Crude Oil distillation column where the feed to,

and the products from, the unit is a continuous operation. In the distillation process, the crude oil
feed is first heated by exchanging heat with some of the hot products leaving the column. This
cools the products and, at the same time reduces the fuel requirements in the main heater - the
fuel fired furnace. The hot feed now enters the tower into the 'Flash Zone'. At this point, due to
the greatly increased volume of the column, the lighter components of the crude oil ' Flash Off '
(vaporise), and rise up the column. The hot liquid will fall towards the column bottom. The
bottom section of the column, below the Flash Zone, called the 'Stripping Section', contains
trays — generally Bubble-cap or Sieve type. The tower bottom liquid is re-circulated & re-heated
in a steam or fired 'Reboiler' which drives off vapours of light ends and some of the heavy ends
contained in the liquid. These vapours rise upwards through the trays and contact the down-
flowing liquid. This action further removes (strips out), light ends from the liquid. The top
section of the tower, above the flash zone, is called the 'Rectifying Section'. Here again, the

rising vapour passing through the trays, contacts the liquid flowing across them.

CONDENZER

REFLLX DRLUM

EMRICHING REFLUX
(RECTIFICATION
SECTION
DISTILLATE
FEED — J _____
STRIPPING
SECTION) [===== HEAT IN
REBOILER | rﬁ :ﬂ T
=_)
e F
Tl HEAT OUT
BOTTOMS

Fig. 4.8 Different Sections and Components of Distillation Column
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4.5.1 Action of the Trays: Each tray in the tower is acting like a single still as discussed in
‘Batch Distillation’. As we rise above the flash zone, each succeeding tray is slightly cooler than
the tray below. The down-flowing liquid, as it passes across the trays is becoming hotter and
heavier as light ends boil off into the vapour phase. Conversely, the rising vapour is becoming
cooler and lighter as heavier ends condense into the liquid on the tray. The down-flowing liquid
is called ‘Internal Reflux’ where the liquid is returned to the preceding still. At pre-determined
points in the column, the process conditions (mainly temperature and pressure), are such that, the
liquid components are at the required purity to meet the specification desired as a product — like
‘Kerosene’ for example. At these points, the tower will contain ‘Collecting Pans’ from which

the desired product can be drawn from the tower.

4.6 CONCLUSION: This chapter has dealt with the basic distillation process and the

components of the distillation column.
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CHAPTER V
MATHEMATICAL MODELING AND CONLTROL OF
DISTILLATION PROCESS/COLUMN

5.1 INTRODUCTION: Various processes are involved in the industries and to make them

efficient, controlling of these processes has to be done. Various control strategies are employed
for the purpose. The plant, control system, actuator, feedback devices, Sensor, in whole,
completes a process control system. Application of the control system to a plant is a two sided
sword; the whole system can become unstable or inefficient if the control system is not
appropriately designed. Since the components of the control system are very expensive, and
design of the control system is a time consuming process, it makes real time testing of the
application of the control system practically impossible. Thus an alternative technique exists in
which the equations which govern the plant behavior is first stated and then transfer equation
which relate the plant output and the input is build. The controller is then designed
mathematically and then analyzed, with various testing tool available such as root locus
techniques, Nyquist criterion, Routh Hurwitz method, Bode Plot analysis, for the various
performance criterions. One of the most important tasks in the analysis and design of control
system is Mathematical Modeling of the systems. The most common methods of the modeling
of the linear systems are Transfer Function approach and the State Equation approach. The
Transfer function approach is valid only for the linear system and the state equation approach is
valid for both, i.e., linear as well as non-linear systems. In reality, since all physical systems are
non-linear to some extent, in order to use transfer functions and linear state equations the system

must first be linearized, or its range of operation be confined to a linear range.

Although the analysis and design of linear control system have been well developed, their
counter parts for non-linear systems are usually quite complex. Therefore, the control systems
engineer often has the task of determining not only how to accurately describe a syatem
mathematically, but more importantly, how to make proper assumptions and approximations,
whenever necessary, so that the system may be adequately characterized by a linear

mathematical model [29].
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5.2 MODELING OF DISTILLATION COLUMN: Distillation column, as described earlier is

a long tower comprising of several components, which are responsible for the energy and mass
transfer, such as, [9]

1. Trays (or stills), to enhance component separations,

2. Reboiler, to provide necessary heat for vaporization for the distillation process,

3. Condensor, to cool and condense the vapour leaving the top of the column

4. Reflux Drum, to hold the condensed vapour from the top of the column so that a part of

that liquid can be fed back (Reflux) to the column,

and some other components to enhance the efficiency of the column and hence the whole
process.
These basic components stated above indulge in the vapour and liquid mixing and transfer of the
mass and energy from one stage to another. This energy and mass transfer can be modeled using
differential equations.
This dissertation only deals with binary distillation column model. To model a binary distillation
column, there are namely following components,
Reflux drum
Condensor
Top Tray
Rectification zone trays
Feed Tray
Stripping zone trays

Bottom Tray

S A O R

Column Base and Reboiler.

To model this system some assumptions have been used, such as, the binary system (two
components) has constant relative volatility throughout the column and theoretical (100%
efficient) trays. A 100% efficient tray is a tray, in which vapour leaving a tray is in equilibrium

with the liquid on the tray. So, the simple vapour liquid equilibrium is used,

ax,

yn=1+(a—1)xn

~ (5.1)
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Where,
Xn = Liquid composition on the nth tray (mole fraction more volatile component)
yn = Vapour composition on the nth tray (more fraction more volatile component)

a = Relative volatility.

A single feed stream is fed as saturated liquid (at its bubble point) onto the feed tray Ng. Feed
flow rate is F (mol/min) and composition is z (mole fraction more volatile component). The
overhead vapour is totally condensed in condenser and flows into the reflux drum, whose holdup
of liquid is Mp (moles). The contents of the drum is assumed to be perfectly mixed with
composition xp. The liquid in the drum is at its bubblepoint. Reflux is pumped back to the top

tray (Nt) of the column at the rate L. Overhead distillate product is removed at a rate D.

Any delay time is neglected (dead time) in the vapour line from the top of the column to the
reflux drum and in the reflux line back to the top tray. The vapour content at the top tray yntis

not equal , dynamically, to xp. These two components are equal only at the steady state.

At the base of the column, the liquid bottom product is removed at a rate B and with a
composition xg. Vapour boilup is generated in a thermosiphon reboiler at a rate V. Liquid
circulates from the bottom of the column through the tubes in the vertical tube-in-shell reboiler
because of the smaller density of the vapour liquid mixture in the reboiler tubes. It is assumed
that the liquids in the reboiler and in the base of the column are perfectly mixed together and
have the same composition xg and holdup Mp (moles). The circulation rates through well-
designed thermosiphon reboilers are quite high, so this assumption is applicable here. The
composition of the vapor leaving the base of the column and entering tray 1 is Yg. It is in

equilibrium with the liquid having composition xg.

The column contains a total of Nt theoretical trays. The liquid holdup on each tray including the
downcomer is M,, The liquid on each tray is assumed to be perfectly mixed with composition X.
The holdup of the vapor is assumed to be negligible throughout the system. Although the vapour
volume 1is large, the number of moles is usually small because the vapor density is so much

smaller than the liquid density. This assumption brakes down in high-pressure columns.
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A further assumption taken is that of equimolal overflow. If the molar heats of the vaporization
of the two components are about the same, whenever one mole of vapor condenses, it vaporizes a
mole of liquid. Heat losses up the column and temperature changes from tray to tray (sensible-
heat effects) are assumed negligible. These assumptions mean that the vapor rates through the

stripping section and the rectifying sections will be constant under the steady state conditions.

The assumption above stated, including negligible vapour holdup, mean that the vapour rate

through all trays of the column is the same, dynamically as well as at steady state.

V:V1:V2: V3:.....:VNT - (5.2)

These vapour holdups are equal only at the steady state and are not necessarily constant with the
time. The vapour boilup can be manipulated dynamically. The mathematical effect of assuming

equimolal overflow is that, modeling doesn’t need an energy equation for each tray.

The liquid rates is not same throughout the column, they will depend on the fluid dynamics of
the tray. A simple Francis Weir formula relationship has been used to relate the liquid holdup on

the tray (M,) to the liquid flow rate leaving the tray (L,).

F, = 3.33L,,(hoy)*?® —(5.3)
Where,
F, = liquid flow rate over weir (ft3/sec)
Lw = length of weir (ft)

hew = height of liquid over weir (ft).

One more assumption which has been made is neglecting the dynamics of the condenser and the
reboiler. Since, in continuous type columns the, dynamic response of these heat exchangers is

usually much faster than the response of the column itself.

Delhi Collage of Engineering Page 47



Modeling and Control of Binary Distillation Column usin LabVIEW

5.2.1Differential Equations related to Differential column: Taking all the above assumptions,

now the equations which describe the system can be stated as,

Condenser and Reflux Drum:
Total Continuity:

M,
——=V-(L+D) — (5.4)

Component Continuity (more volatile component):

d(Mpxp)
% = Vynr — (L + D)xp — (5.5)

Top Tray (n = Ny):

Total Continuity:

dt = L - LNT - (5.6)

Component Continuity (more volatile component):

d(MyrxnT)
— dr = Lxp — Lyrxyr + Vynr—1— Vynr = (5.7)

Next to Top Tray (n = Nt -1):
Total Continuity:

dMyr_
(IivtT L= Lyt — Lyr—1 —(5.8)

Component Continuity (more volatile component):

d(Myr-1Xn7-1) _

dt Lyt Xyt — Lyr—1 Xn7—1 + VYnr—2 — VYNnT—1 - (5.9)
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n™ Tray:
Total Continuity:

dM,
dr =Lpi1 — Ln —(5.10)

Component Continuity (more volatile component):

d(Mpxy) _

dt = Lpy1 Xn41 — Lnxp + Vynog— Vo —(5.11)
Feed Tray (at n= Ny):
Total Continuity:
T Lyp+1 — Lyp + F - (5.12)

Component Continuity (more volatile component):

d(Mypxnr)
dt

= Lyp+1 XnF41 — Lvr Xne + VYnp-1— Vyne + Fz —(5.13)
First Tray:

Total Continuity:

dM
d—tl =L, - L, — (5.14)

Component Continuity (more volatile component):

d(Myx,)

dt = L2 xz - L1 x1 + Vyb_ Vyl - (5.15)
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Reboiler & Column Base:
Total Continuity:

dMp
dt

L,-V-B — (5.16)

Component Continuity (more volatile component):

= Ll x1 - Vyb - BxB - (5.17)

Based on above equations, the mathematical model of the distillation column has been designed
in the LabVIEW. Top product (Distillate) composition and the bottom product composition are
the output i.e. Controlled variables of the plant system, and the manipulate variables are the

Reflux Rate (L) and the Vapour Boilup Rate (V).

5.3 INTRODUCTION TO PROCESS CONTROL: A controller generates the control signal

based on the control strategy employed and the input variable. The input variable to a controller

is the error i.e. difference between the

There are various types of process control strategies such as:
e Feed back control
¢ Feed forward Controller
e (Cascade Controller
e Adaptive Controller
e IMC based Controller
e Robust Controller etc.

In all above techniques the Feedback controller is the oldest. The combinations of the above said

controllers are also employed to enhance the performance of the overall control system. Like,
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Feedforward controller, feedback controller, cascade controller are usually employed

cumulatively so as to reject disturbance and control the process variable effectively.
Feedback controllers have different types, which are as follows,

(a) On — Off Controller

(b) Proportional Controller

(c) Proportional Integral Controller

(d) Proportional Integral Derivative controller

These all controllers have a reference input and output measurement in form of FEEDBACK
making these under the heading of closed loop control strategy. A closed loop control strategy
takes reference input or the set point and the output value, which is to be controlled, as the
feedback. The controlling action is then generated according to the specified controller algorithm

depending upon the error which is set point minus feedback signal.

5.3.1 ON - OFF Controller:

In this type of controller the control signal sent to the actuator is either 0% or 100% e.g.
in the water tank level control let there be two valves controlling the outflow and the
inflow, suppose valvel(V 1for the inflow) is chosen for the controlling purpose . A motor
is employed as the actuator which opens or closes the valve according to current supplied

to it.

Now suppose set point is lesser than the current output level then the inflow valve should
be open i.e. controlling signal applied to the motor must 20 be mA according to the
standards. Due to the 20mA current the motorized valve gets fully open. And the level in
the tank rises up to the point where the level becomes greater than the set point. In off

mode the control signal is 4mA.
The control strategy can be defined as

SET POINT > FEEDBACK — CONTROLLER OUTPUT = 100%
SET POINT <=FEEDBACK — CONTROLLER OUTPUT = 0%
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The ON- OFF controller results in the continuous on off of the controller, and thus
producing the oscillations in the output. That’s why this controller is not used in the
sophisticated environment. It is used generally in the heater temperature control system or

the oven temp. Control system.

5.3.2 Proportional Controller:

In this type of controller the control signal is proportional to the error signal . For
example let the error be denoted as 'e' and controller output is denoted by 'c ', then the

controller output can be calculated as

c=K,.e - (5.18)
Where, ' K}, ' is the proportional constant.

This type of the controllers generates the offset error in the output i.e. a steady state error

is generated in the output.

Fig 5.1 Block Diagram of Proportional Controller
5.3.3 Proportional plus integral Controller:

To remove the steady state error the integral of the error is taken and added to the

proportional control action.
The controller output can be written as:
c=Kp.e+Kifedt —(5.19)

This type of controller improves the steady state error but doesn't affect the transient
response.
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Fig. 5.2 Block Diagram of PI Controller

5.3.4 Proportional plus Integral plus Derivative Controller:

This type of controller generates a control signal which is proportional + integral +
derivative of the error. The added term corresponds to the derivative of the error which

improves the transient response of the system.

The control action can be formulated as

de
c=Kp.e+Kifedt+ Kd% —(5.20)

This controller has the advantage of all the three types of the corrective actions.

Fig. 5.3 Block Diagram of PID Controller
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5.4 CONTROLLER DESIGN FOR THE DISTILLATION COLUMN:

In the present dissertation the model for the distillation column is developed on the basis of the
physical laws and equations given by the William L. Luyben [9]. Section 5.2 has described the
equation involved in the modeling for the column. The control scheme for controlling the

composition of the products is then has been decided on the basis of these equations.

Two controllers controlling the liquid holdup in the column base and reflux drum are also
employed. The feed rate F and the composition Z are given and are taken as the disturbances for

the plant. Now to examine the degree of freedom of the system,[9]

5.4.1 Number of Variables:

Name of Variables No.
Tray composition (x, and y,) 2Nt
Tray liquid flows (L,) Nr
Tray Liquid holdups (M,) Nr
Reflux Drum composition (Xp) 1
Reflux Drum flows (L & D) 2
Reflux Drum Holdup (Mp) 1
Base Composition (xg & yg) 2
Base Flows (V and B) 2
Base Holdup (Mp) 1
TOTAL 4Nt +9

Table 5.1 No. of Variables in Distillation Column Modeling
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5.4.2 Number of Equations:

Name of Variables No.
Tray component continuity Nt
Tray total continuity Nt
Equilibrium (Trays plus Base) Nt +1
Hydraulic Nt
Level Controllers 2
Reflux Drum component continuity 1
Reflux Drum total continuity 1
Base component continuity 1
Base total continuity 1
TOTAL 4Nt +7

Table 5.2 No. of Equations in Distillation Column Modeling

Therefore the system is underspecified by two equations. This means that there are only two
variables that can be controlled (can be fixed/manipulated). The two variables that must

somehow be specified are reflux flow Rate L and vapor boilup rate V (or heat input to the

reboiler). They can be held constant (an openloop system) or then can be changed by two
controllers to try to hold some other two variables constant. In the present dissertation the two
controllers which manipulate these variables are decoupled PID controllers, which are used to

control the composition of the top and the bottom products.
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5.5 MODEL PARAMETERS AND NOMINAL OPERATING POINT: The values of the

model parameters used in this dissertation are as follows, [4]

Parameter Value
No of trays 20
Feed tray 10
Relative volatility 1.5
Feed composition, mole fraction (zy) 0.55
Feed condition Saturated liquid
Feed flow rate, Kmol/min 1
Distillate composition, mole fraction 0.96
Bottom product composition, mole fraction 0.04
Reflux rate, Kmol/min 2.7063
Boil up rate, Kmol/min 3.2063
Liquid holdup in condenser 0.50
Liquid holdup in the reboiler 0.50

Table 5.3 Distillation Column Model Parameters

5.6 CONCLUSION: An extensive discussion on the equations governing the distillation column
behavior has been discussed and a base for the modeling of the system in LabVIEW has been

built.
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CHAPTER VI

Distillation Column Modeling & Control using LabVIEW

6.1 INTRODUCTION: In this dissertation modeling has been done in LabVIEW software.

LabVIEW has a dedicated software which only deals with the Control Design and Simulations of
the different plant models and control system. This part of LabVIEW is very similar to the
SIMULINK of the MATLAB by MathWorks Inc. SIMULINK contains different toolboxes
which deals with simulations of the different system such as Hydraulic Systems, Electrical
Systems etc. LabVIEW also has different toolboxes which include PID Toolbox, Fuzzy control
Toolbox, and different toolbox which deals with simulations of the plant such as Linear Systems,

Non linear System, Simulation Loop etc.

This chapter discusses how the different equations depicting the behavior of the distillation

column, and how the controller for distillation column have been designed in the LabVIEW.

6.2 PROGRAMMING IN LABVIEW/Block Diagram: This section has a detailed explanation
of how the programming has been done to simulate the distillation column and how the
controller has been employed.

6.2.1 Implementation of the model in LabVIEW: This distillation column model has been
divided in six (6) parts. To simulate the model, each has been arranged and interconnected in a
specified manner according to the differential equations, as the outputs of many equations serve
as the input to some other equations. Different parts/subsystems and their block diagram

programming, are as following,

6.2.2 Subsystem: A subsystem is a compact representation of a block diagram programming.
The whole programming is under the mask and only the input and output terminal are accessible
in the main window. A subsystem is in itself a complete program and act according to the
program. It has its own front panel in which user can verify the output, whether it is according to
specifications or not. The subsystem approach can be compared to the user defined function of

the high languages like C, C++, or Visual Basic etc. the subsystem approach is very helpful
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when a repetitive function has to be done. The model for the distillation column has different

trays and each tray has same differential equation, except Feed tray, top tray, and Bottom Tray,

with different values of the input and the output, so a dedicated subsystem for evaluating the

differential equation has been employed here for the programming.

1. N*® tray: The equation of the n® tray has two inputs i.e. x,+; and x,.; and one output

i.e. x,. In addition to that a vapour liquid equilibrium has also been used to calculate

the value of y,. This value of y, is being used to solve equation further. The equation

for the n" Tray is as under,

d(Mnxn) _

- Ln+1 Xn4+1 — Ln Xn + VYn—l - VYn - (5-11)

The subsystem for the n™ tray is shown below,

—

Fig 6.1 Subsystem for n™ Tray

Block diagram for the subsystem of n" tray has been shown in following fig.,

"
----- —
I-ﬁ.23[> I> A
L 30 —
Bs——F x> o
Lnt+l]ig.s +_ |
.
0.5 |>
bim- mn-1
'!f"w‘ jvn-1yn-1
S R = I},
1
Fig 6.2 Block Diagram for n" Tray
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2. Feed Tray: The equation of the Feed tray has four inputs i.e. X,+;, X4-7, Xy and zy and
one output i.e. xyr. In addition to that a vapour liquid equilibrium has also been used
to calculate the value of yyr. This value of yygis being used to solve equation further.

The equation for the Feed Tray is as under,

d(Mypxyr)
dt
= Lyps1 XNF41 — Lyr Xne + VYnp-1 — Vyne + 25
_ (5.13)

The subsystem for the Feed tray is shown below,

Feed Tray

Fig 6.3 Subsystem for Feed Tray

Block diagram for the subsystem of Feed Tray has been shown in following fig.,

]
n &
fizap &
1
| 2 ]
iz (B> I 2 e E3 putput
' 0.5 T- f
123
& I> [
Nzsh 0.5
1 xn-1
%-’Ej‘ Wri-1yn-1

23 = I>

Fig 6.4 Block Diagram for Feed Tray
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3. Vapor - Liquid Equilibrium: A vapor liquid equilibrium has been used to predict
the value of the liquid and the vapor amount on the trays. The subsystem and equation

related to vapor liquid equilibrium is shown as under,

ax,

G —OD

Yn

o

Fig.6.5 Subsystem for Vapor liquid equilibrium

Block diagram for the subsystem of Vapor Liquid Equilibrium has been shown in

following fig.,
il
G230
q 0.5
[z
123

Fig. 6.6 Block Diagram for the Vapor Liquid Equilibrium
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4. Condenser and Reflux Drum: The differential Equations related to the Condenser

and reflux drum are as follows,

d(Mpxp)

dt
The equation for the condenser and reflux drum are not iterative, hence is not made as

subsystem and are used directly in the block diagram, as under,

P .
=d I:’>

=
—1 =

'

L

iy

=
=]
m

xn

Fr
Fig. 6.7 Block Diagram for Reflux Drum

5. Top Tray: Top tray is the upper most tray in the distillation column and its
differential equation is somewhat different from other trays, as the part of the

distillate is fed back to the top tray. This feedback is known as Reflux. The equation

for the tray is,

d(Myrxnt)
—a Lxp — Lyt xyr + Vynr—1— Vynr - (5.7)

The block diagram programming is as under,

] e
= 50 TR
- I> g?9 I>
L
T a2
1 |>
0.5
-1
Fig. 6.8 Block Diagram for Top Tray
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6. Column Base: The equation for the column base and Reboiler is as under,

d(Mgxg)

dt = L1 xl - Vyb - BxB - (5.17)

The block Diagram for the column Base and Reboiler is shown in fig. ,

<b
]

._&

|> Wb

T W
1 = =5
i &
-

B
Fig. 6.9 Block Diagram for Column Base and Reboiler

On arranging these different block diagrams, a complete model for the ideal binary distillation

column has been built. Different trays have been arranged, such that the output of one serves as

input to other, in order to satisfy the differential equations.

_

d )

I
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Fig. 6.10 Interconnection of different trays

6.3 FRONT PANEL: Front Panel is the space where the distillate and the bottom composition
monitoring and values for the different parameters of the controller can be varied by the user.

Front panel for the above described Programming is shown in Fig. 6.11,

Fig. 6.11 Front Panel of Distillation Column Model

6.4 CONCLUSION: Implementation of the distillation column model through different
available icons in LabVIEW library has been presented in the chapter.
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CHAPTER VII

Results and Discussion

The model for Distillation Column is linearized around the point [99.25%, .25%] i.e. the
distillate composition and the bottom product composition respectively. A step change of
magnitude [.5 %] in the composition has been fed to the system and the variation in the
composition of the top and the bottom product has been analyzed. Different combinations of the
values for K),, T, Tphas been used to observe the variation of the composition of the products.

7.1 LIST OF CONTROL STRATEGIES AND THEIR PARAMETERS’ VALUES:

PARAMETERS’ VALUES
CASE CONTROL Controller 1 Controller 2
STRATEGY
Ky Ty Ta Ky Ty, Ta
Case I P Control 49.095 - - 32.183 - -
Case 11 PI Control |24.7486 | 9.24609 - 28.1027 7.3494 -
Case III PI Control | 16.9575 | 2.9749 - 24.6525 2.4616 -
Case IV PID Control | 68.937 | 6.28185 .3295 29.605 4.928 1169
Case V PID Control 15.3594 | 6.54891 .1891 21.848 4.363 1857
Table 7.1 List of Parameters for different Controllers
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Case 1: Simple Proportional Controller:
Kp1 = 49095

Kp, =32.183

Distillate Composition (%)

Bottom Composition (%)

Simulation time {sec.]

Fig. 7.1 Variation of Distillate & Bottom Composition v/s Time (P Control)
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Case 2: Proportional Integral Control:

Kp; =24.7486 Ti1 =9.24609

Kp, =28.1027 Tio=7.3494

Distillate Compaosition (%]

T L O D O T
90 %5 100 105 110 115 120

Simulation Time {Sec.]

Bottom Compaosition (%)

O
a5 100 105 110 115 120

Simulation Time (Sec.)

Fig. 7.2 Variation of Distillate & Bottom Composition v/s Time (PI Control)
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Case 3: Proportional Integral Control:
Kp; =16.9575 Ti1=2.9749

Kp, =24.6525 Tin=2.4616

Distillate Composition | %)

O O LD
95 100 105 110 115 120

Simulation Time (Sec.]

Bottom Composition | %)

O O
40 45 S0 55 &0 65 7D @) 9 100 105 110 115 120

Simulation Time (Sec.)

Fig. 7.3 Variation of Distillate & Bottom Composition v/s Time (PI Control)
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Case 4: Proportional Integral Derivative Control:

Kpi = 68.937 T;1=6.28185 Ty1=.3295

Kp, =29.605 Tin =4.928 Ts1=.1169

9.7 -
09,65 =
G =
5 _EE —
e

30,35 =
gg 3=
" -u:.

Distillate Composition (%)

';I.'!- :l"' lIII 1II"' !III lL"' l1'I

Simulation Time (Sec.)

Bottom Composition (%)

15 1_II '- :\: HI -15 '5'5 MI IE.'F- I:I:l ]II'- |_]II I.I_'E ]II

Simulation Time (Sec.)

Fig. 7.4 Variation of Distillate & Bottom Composition v/s Time (PID Control)
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Case 5: Proportional Integral Derivative Control:

Kpi =15.3594 Ti1=6.54891 Ta1=.1891

Kp, =21.848 Ti2 =4.363 Tys1=.1857

Distillate Composition (%)

Simulation Time (Sec.]

Bottom Compaosition (%)

Simulation Time (Sec.)

Fig. 7.5 Variation of Distillate & Bottom Composition v/s Time (PID Control)
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7.2 DISCUSSION ON RESULTS: Various parameters which depict the performance of the

control strategy applied to the model are summarized in the following table.

SUMMARY OF THE RESULTS:

CASE Max. Overshoot Settling Time Steady state Desired

(%) Error Response

Achieved?
Case I NA Very Large Very Large NO
Case 11 1% 37 sec. Negligible NO
Case III No overshoot 51 sec. Negligible NO
Case IV .04% 80 sec Large NO
Case V 03% 26.4 sec Negligible YES

Table 7.2 List of Different parameters depicting performance

Case I: In this strategy only proportional controller is applied and the Steady state error found to
be very large, thus the controller was not acceptable.

Case II: In this a PI controller is employed, although steady state error came down as integral
controller has been added, but the Settling time and overshoot are still not acceptable, thus the PI
controller with the said values of parameters is not acceptable.

Case III: In this strategy also a PI Controller is employed with different values of the
parameters. This case does not any overshoot but the Settling Time has been increased to 51 sec.
Though the Controller has brought down the steady state error to a permissible limit but due to
increased value of the setting time the controller is not acceptable.

Case IV: Derivative Controller has been introduced along with the PI Controller used in the
Case 2 and 3. In this case, although the overshoot has been reduced significantly, but due to poor
tuning of the parameters of the controller, the response is not desirable.

Case V: In this case, PID controller with tight tuning of the parameters is used. Steady state error
has been removed by application of the integral controller and the transient response has been
improved with the application of the derivative controller. The overshoot has been reduced to a
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value of .03% and the settling time is also reduced to the value of 26.4 sec, and the strategy is
found most suitable.

7.3 FUTURE SCOPE OF THE WORK:

In this dissertation a mathematical model and a suitable control strategy has been applied. The
mathematical model in the present work is based on the molar concentrations of the components
in the product streams and according to them a controller has been employed. The present work
can be further explored in areas, such as, instead of the molar concentrations, the mass flows can
be used to develop a model for the column and hence a controller to make the distillation process
energy efficient and effective. More advanced controllers such as robust controller, Fuzzy
Controller, and Neural Controller can also be studied for their feasibility to be employed with
distillation column dynamics.

Moreover, the present work can be extended to a real distillation column and the process
variables can be fed to the LabVIEW with the aid of a Data Acquisition card. The Process
variables can be the temperature of the trays, outputs of the chromatographs which can infer the
composition of the components in the product stream. Consequently the manipulated variables
according to the control strategy employed can be varied in order to keep the composition of the
components of desired value.
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